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Legal Information
The information provided in this document contains general descriptions, technical
characteristics and/or recommendations related to products/solutions.

This document is not intended as a substitute for a detailed study or operational and
site-specific development or schematic plan. It is not to be used for determining
suitability or reliability of the products/solutions for specific user applications. It is the
duty of any such user to perform or have any professional expert of its choice
(integrator, specifier or the like) perform the appropriate and comprehensive risk
analysis, evaluation and testing of the products/solutions with respect to the relevant
specific application or use thereof.

The Schneider Electric brand and any trademarks of Schneider Electric SE and its
subsidiaries referred to in this document are the property of Schneider Electric SE or
its subsidiaries. All other brands may be trademarks of their respective owner.

This document and its content are protected under applicable copyright laws and
provided for informative use only. No part of this document may be reproduced or
transmitted in any form or by any means (electronic, mechanical, photocopying,
recording, or otherwise), for any purpose, without the prior written permission of
Schneider Electric.

Schneider Electric does not grant any right or license for commercial use of the
document or its content, except for a non-exclusive and personal license to consult it
on an "as is" basis.

Schneider Electric reserves the right to make changes or updates with respect to or in
the content of this document or the format thereof, at any time without notice.

To the extent permitted by applicable law, no responsibility or liability is
assumed by Schneider Electric and its subsidiaries for any errors or omissions
in the informational content of this document, as well as any non-intended use
or misuse of the content thereof.
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Safety Information

Important Information
Read these instructions carefully, and look at the equipment to become familiar
with the device before trying to install, operate, service, or maintain it. The
following special messages may appear throughout this documentation or on the
equipment to warn of potential hazards or to call attention to information that
clarifies or simplifies a procedure.

Please Note
Electrical equipment should be installed, operated, serviced, and maintained only
by qualified personnel. No responsibility is assumed by Schneider Electric for any
consequences arising out of the use of this material.

A qualified person is one who has skills and knowledge related to the construction
and operation of electrical equipment and its installation, and has received safety
training to recognize and avoid the hazards involved.

Before You Begin
Do not use this product on machinery lacking effective point-of-operation
guarding. Lack of effective point-of-operation guarding on a machine can result in
serious injury to the operator of that machine.

The addition of this symbol to a “Danger” or “Warning” safety label indicates that an 
electrical hazard exists which will result in personal injury if the instructions are not 
followed.

This is the safety alert symbol. It is used to alert you to potential personal injury 
hazards. Obey all safety messages that follow this symbol to avoid possible injury or 
death.

DANGER indicates a hazardous situation which, if not avoided, will result in death or serious 
injury.

! DANGER

WARNING indicates a hazardous situation which, if not avoided, could result in death or 
serious injury.

WARNING!

CAUTION indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury.

CAUTION!

NOTICE is used to address practices not related to physical injury.

NOTICE
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WARNING
UNGUARDED EQUIPMENT
• Do not use this software and related automation equipment on equipment

which does not have point-of-operation protection.
• Do not reach into machinery during operation.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.

This automation equipment and related software is used to control a variety of
industrial processes. The type or model of automation equipment suitable for each
application will vary depending on factors such as the control function required,
degree of protection required, production methods, unusual conditions,
government regulations, etc. In some applications, more than one processor may
be required, as when backup redundancy is needed.

Only you, the user, machine builder or system integrator can be aware of all the
conditions and factors present during setup, operation, and maintenance of the
machine and, therefore, can determine the automation equipment and the related
safeties and interlocks which can be properly used. When selecting automation
and control equipment and related software for a particular application, you should
refer to the applicable local and national standards and regulations. The National
Safety Council's Accident Prevention Manual (nationally recognized in the United
States of America) also provides much useful information.

In some applications, such as packaging machinery, additional operator protection
such as point-of-operation guarding must be provided. This is necessary if the
operator's hands and other parts of the body are free to enter the pinch points or
other hazardous areas and serious injury can occur. Software products alone
cannot protect an operator from injury. For this reason the software cannot be
substituted for or take the place of point-of-operation protection.

Ensure that appropriate safeties and mechanical/electrical interlocks related to
point-of-operation protection have been installed and are operational before
placing the equipment into service. All interlocks and safeties related to point-of-
operation protection must be coordinated with the related automation equipment
and software programming.

NOTE: Coordination of safeties and mechanical/electrical interlocks for point-
of-operation protection is outside the scope of the Function Block Library,
System User Guide, or other implementation referenced in this
documentation.

Start-up and Test
Before using electrical control and automation equipment for regular operation
after installation, the system should be given a start-up test by qualified personnel
to verify correct operation of the equipment. It is important that arrangements for
such a check are made and that enough time is allowed to perform complete and
satisfactory testing.

WARNING
EQUIPMENT OPERATION HAZARD
• Verify that all installation and set up procedures have been completed.
• Before operational tests are performed, remove all blocks or other temporary

holding means used for shipment from all component devices.
• Remove tools, meters, and debris from equipment.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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Follow all start-up tests recommended in the equipment documentation. Store all
equipment documentation for future references.

Software testing must be done in both simulated and real environments.

Verify that the completed system is free from all short circuits and temporary
grounds that are not installed according to local regulations (according to the
National Electrical Code in the U.S.A, for instance). If high-potential voltage
testing is necessary, follow recommendations in equipment documentation to
prevent accidental equipment damage.

Before energizing equipment:
• Remove tools, meters, and debris from equipment.
• Close the equipment enclosure door.
• Remove all temporary grounds from incoming power lines.
• Perform all start-up tests recommended by the manufacturer.

Operation and Adjustments
The following precautions are from the NEMA Standards Publication ICS 7.1-
1995:

(In case of divergence or contradiction between any translation and the English
original, the original text in the English language will prevail.)

• Regardless of the care exercised in the design and manufacture of equipment
or in the selection and ratings of components, there are hazards that can be
encountered if such equipment is improperly operated.

• It is sometimes possible to misadjust the equipment and thus produce
unsatisfactory or unsafe operation. Always use the manufacturer’s
instructions as a guide for functional adjustments. Personnel who have
access to these adjustments should be familiar with the equipment
manufacturer’s instructions and the machinery used with the electrical
equipment.

• Only those operational adjustments required by the operator should be
accessible to the operator. Access to other controls should be restricted to
prevent unauthorized changes in operating characteristics.
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About the Document

Document Scope
This document describes the installation and upgrade of EcoStruxure Control
Expert.

Validity Note
This document has been updated for the release of EcoStruxure Control Expert
16.2.

Product Related Information

WARNING
LOSS OF CONTROL
• Perform a Failure Mode and Effects Analysis (FMEA), or equivalent risk

analysis, of your application, and apply preventive and detective controls
before implementation.

• Provide a fallback state for undesired control events or sequences.
• Provide separate or redundant control paths wherever required.
• Supply appropriate parameters, particularly for limits.
• Review the implications of transmission delays and take actions to mitigate

them.
• Review the implications of communication link interruptions and take actions

to mitigate them.
• Provide independent paths for control functions (for example, emergency

stop, over-limit conditions, and error conditions) according to your risk
assessment, and applicable codes and regulations.

• Apply local accident prevention and safety regulations and guidelines.1

• Test each implementation of a system for proper operation before placing it
into service.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

1 For additional information, refer to NEMA ICS 1.1 (latest edition), Safety
Guidelines for the Application, Installation, and Maintenance of Solid State Control
and to NEMA ICS 7.1 (latest edition), Safety Standards for Construction and
Guide for Selection, Installation and Operation of Adjustable-Speed Drive
Systems or their equivalent governing your particular location.

WARNING
UNINTENDED EQUIPMENT OPERATION
• Only use software approved by Schneider Electric for use with this

equipment.
• Update your application program every time you change the physical

hardware configuration.
Failure to follow these instructions can result in death, serious injury, or
equipment damage.
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The examples given herein are for information only.

WARNING
UNINTENDED EQUIPMENT OPERATION

Adapt examples given herein to the specific functions and requirements of your
industrial application before you implement them.

Failure to follow these instructions can result in death, serious injury, or
equipment damage.

General Cybersecurity Information
In recent years, the growing number of networked machines and production plants
has seen a corresponding increase in the potential for cyber threats, such as
unauthorized access, data breaches, and operational disruptions. You must,
therefore, consider all possible cybersecurity measures to help protect assets and
systems against such threats.

To help keep your Schneider Electric products secure and protected, it is in your
best interest to implement the cybersecurity best practices as described in the
Cybersecurity Best Practices document.

Schneider Electric provides additional information and assistance:
• Subscribe to the Schneider Electric security newsletter.
• Visit the Cybersecurity Support Portal web page to:
◦ Find Security Notifications.
◦ Report vulnerabilities and incidents.

• Visit the Schneider Electric Cybersecurity and Data Protection Posture web
page to:
◦ Access the cybersecurity posture.
◦ Learn more about cybersecurity in the cybersecurity academy.
◦ Explore the cybersecurity services from Schneider Electric.

Product Related Cybersecurity Information
Refer to Modicon Controller Systems Cybersecurity, User Guide under Related
Documents, page 9.

Available Languages of the Document
The information contained herein is available in these languages:

• English (35014793)
• French (35014792)
• German (35014794)
• Spanish (35014795)
• Italian (35014796)
• Chinese (35012191)

NOTE: After clicking one of the above download links, you may need to select
your country before you can download the documentation.
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https://www.se.com/ch/fr/download/document/35014796K01000/
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Related Documents
Title of documentation Reference number

Modicon Controller Systems Cybersecurity, User
Guide

EIO0000001999 (ENG)
EIO0000002004 (CHS)
EIO0000002001 (FRE)
EIO0000002000 (GER)
EIO0000002002 (ITA)
EIO0000002003 (SPA)

Schneider Electric License Manager, User
Manual

EIO0000001070 (ENG)
EIO0000001071 (FRE)
EIO0000001072 (GER)
EIO0000001074 (SPA)
EIO0000001073 (ITA)
EIO0000001075 (CHS)

Schneider Electric Floating License Manager,
User Manual

EIO0000001078 (ENG)
EIO0000001079 (FRE)
EIO0000001080 (GER)
EIO0000001082 (SPA)
EIO0000001081 (ITA)
EIO0000001083 (CHS)

EcoStruxure™ Control Expert, Security Editor,
Operation Guide

EIO0000004105 (ENG)
EIO0000004106 (FRE)
EIO0000004107 (GER)
EIO0000004108 (ITA)
EIO0000004109 (SPA)
EIO0000004110 (CHS)

EcoStruxure™ Control Expert, Topology
Manager, User Manual

EIO0000002756 (ENG)
EIO0000004373 (CHS)
EIO0000004371 (FRE)
EIO0000004372 (GER)
EIO0000004370 (ITA)
EIO0000004369 (SPA)

EcoStruxure™ Control Expert, Operating Modes 33003101 (ENG)
33003102 (FRE)
33003103 (GER)
33003104 (SPA)
33003696 (ITA)
33003697 (CHS)

EcoStruxure™ Control Expert, Program
Languages and Structure, Reference Manual

35006144 (ENG)
35006145 (FRE)
35006146 (GER)
35006147 (SPA)
35013361 (ITA)
35013362 (CHS)

EcoStruxure™ Control Expert, Control, Block
Library

33002535 (ENG)
33002536 (FRE)
33002537 (GER)
33003686 (ITA)
33002538 (SPA)
33003687 (CHS)

Communication Drivers, Installation Manual 35006152 (ENG)
35006153 (FRE)
35006154 (GER)
35013950 (ITA)
35006155 (SPA)
35012192 (CHS)

Modicon M580, Complex Topologies, System
Guide

NHA58892 (ENG)
NHA58893 (FRE)
NHA58894 (GER)
NHA58895 (ITA)
NHA58896 (SPA)
NHA58897 (CHS)

To find documents online, visit the Schneider Electric download center
(www.se.com/ww/en/download/).
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Information on Non-Inclusive or Insensitive Terminology
As a responsible, inclusive company, Schneider Electric is constantly updating its
communications and products that contain non-inclusive or insensitive
terminology. However, despite these efforts, our content may still contain terms
that are deemed inappropriate by some customers.
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Terminology Derived from Standards
The technical terms, terminology, symbols and the corresponding descriptions in
the information contained herein, or that appear in or on the products themselves,
are generally derived from the terms or definitions of international standards.

In the area of functional safety systems, drives, and general automation, this may
include, but is not limited to, terms such as safety, safety function, safe state, fault,
fault reset, malfunction, failure, error, error message, dangerous, etc.

Among others, these standards include:

Standard Description

IEC 61131-2:2007 Programmable controllers, part 2: Equipment requirements and tests.

ISO 13849-1:2023 Safety of machinery: Safety related parts of control systems.

General principles for design.

EN 61496-1:2013 Safety of machinery: Electro-sensitive protective equipment.

Part 1: General requirements and tests.

ISO 12100:2010 Safety of machinery - General principles for design - Risk assessment and
risk reduction

EN 60204-1:2006 Safety of machinery - Electrical equipment of machines - Part 1: General
requirements

ISO 14119:2013 Safety of machinery - Interlocking devices associated with guards - Principles
for design and selection

ISO 13850:2015 Safety of machinery - Emergency stop - Principles for design

IEC 62061:2021 Safety of machinery - Functional safety of safety-related electrical, electronic,
and electronic programmable control systems

IEC 61508-1:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: General requirements.

IEC 61508-2:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Requirements for electrical/electronic/programmable
electronic safety-related systems.

IEC 61508-3:2010 Functional safety of electrical/electronic/programmable electronic safety-
related systems: Software requirements.

IEC 61784-3:2021 Industrial communication networks - Profiles - Part 3: Functional safety
fieldbuses - General rules and profile definitions.

2006/42/EC Machinery Directive

2014/30/EU Electromagnetic Compatibility Directive

2014/35/EU Low Voltage Directive

In addition, terms used in the information contained herein may tangentially be
used as they are derived from other standards such as:

Standard Description

IEC 60034 series Rotating electrical machines

IEC 61800 series Adjustable speed electrical power drive systems

IEC 61158 series Digital data communications for measurement and control – Fieldbus for use
in industrial control systems

Finally, the term zone of operation may be used in conjunction with the description
of specific hazards, and is defined as it is for a hazard zone or danger zone in the
Machinery Directive (2006/42/EC) and ISO 12100:2010.

NOTE: The aforementioned standards may or may not apply to the specific
products cited in the present documentation. For more information concerning
the individual standards applicable to the products described herein, see the
characteristics tables for those product references.
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Trademarks
Intel and Intel Core are trademarks of Intel Corporation or its subsidiaries.

Microsoft, Windows, Windows Server, Hyper-V, and Windows Defender are either
registered trademarks or trademarks of Microsoft Corporation in the United States
and/or other countries.

VMware Workstation Pro is either a registered trademark or a trademark of
VMware Inc. in the United States and/or other countries.

Oracle is a registered trademark and VirtualBox is a trademark of ORACLE
AMERICA, INC and/or its affiliates.
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General Information

Presentation of EcoStruxure Control Expert

Installation Media
Install EcoStruxure Control Expert with the installation package (.iso image file)
that you can download from your Schneider Electric country website. Proceed as
follows:

Step Action

1 Visit www.se.com.

2 In the search bar, type Control Expert and press Enter.

3 On the search results page, click Select location to open the Select your location
window.

NOTE: If you do not find the EcoStruxure Control Expert software in the search
results, contact your local Schneider Electric Sales representative.

4 Select your country.

Result: Your country-specific search results are displayed.

5 Click the link to EcoStruxure Control Expert software.

Software Functionality Levels
You can install EcoStruxure Control Expert with two functionality levels.

EcoStruxure Control
Expert

It includes the Topology Manager that manages system projects. One or
more controllers (each with their own control project) and various devices
constitute a system project. The control projects can be managed
individually by starting one or more EcoStruxure Control Expert editor
instances from the Topology Manager.

It uses a client/server architecture, page 14. Setup installs both the
EcoStruxure Control Expert (client) instance and the Control Expert server
on the computer.

The Control Expert repository is the database that is managed by
EcoStruxure Control Expert and contains system project data.

NOTE: Refer to EcoStruxure™ Control Expert, Topology Manager,
User Manual for information on how to work with system projects.

EcoStruxure Control
Expert Classic

It is a single-user application that allows managing one control project at a
time.

Languages
The following display languages are available for EcoStruxure Control Expert and
EcoStruxure Control Expert Classic:

• English
• French
• German
• Spanish
• Italian
• Chinese

After the installation, you can change the display language, page 48.
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EcoStruxure Control Expert Architectures
The following architectures can be used with EcoStruxure Control Expert:

• All-in-one architecture: Consists of one computer where EcoStruxure
Control Expert instances are started and connected locally to the Control
Expert server (default configuration).

• Distributed architecture consisting of:
◦ One computer acting as Control Expert server (EcoStruxure Control

Expert instances that connect locally to the server can also be used on this
computer).

◦ One or more remote computers where EcoStruxure Control Expert
instances are started and connected to the Control Expert server.

The following figure shows an example of a distributed architecture.

NOTE: On each computer of either architecture, you can use EcoStruxure
Control Expert Classic instances concurrently with EcoStruxure Control
Expert.

Ethernet Network

EcoStruxure
Control Expert

instance 1

Ethernet 
Control Network

Control Expert
server

Controller 1

EcoStruxure
Control Expert

instance 2

Controller 2
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System and Installation Requirements

Performance Considerations
The configuration of the computer determines the EcoStruxure Control Expert
performance, which can be affected by the number of open windows, the amount
of animated data that is accessed, and the size of the applications/system projects
that are open.

Hardware and System Requirements
The following table describes the hardware and system requirements to install and
use EcoStruxure Control Expert.

Component Requirements

CPU 3.0 GHz or greater
Intel Core i7 or greater (or equivalent)

RAM 16 GB

Storage 20 GB free space for the software installation, execution, and for saving
applications

SSD drives

Operating system The following operating systems are supported:
• Microsoft Windows 10, 64-bit, version 22H2 or greater
• Microsoft Windows 10 Enterprise LTSC 2021, version 21H2
• Microsoft Windows 11, 64-bit, version 21H2 or greater
• Microsoft Windows Server 2019 Standard, version 1809
• Microsoft Windows Server 2022, version 21H2 or greater

Display VGA (800 x 600) minimum resolution

Maximum supported resolution: 5120 x 1440 with Scale and Layout at 125% or
greater

Input devices Keyboard and mouse or compatible pointing device

Ports USB port

Licenses, page
37

License activation on the Internet
NOTE: Offline activation is also possible.

Operating System Service Pack, Security Patch, and Language
Requirements

Ensure that the latest Windows Service Pack and Security Patches are installed.

Ensure that the language that you select for EcoStruxure Control Expert is
installed on your operating system (for example, Chinese). Otherwise, messages
that are generated by the operating system use the operating system display
language.

35014793.19 15
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.NET Framework Installation Requirements
The following components are required before installing EcoStruxure Control
Expert:

• .NET Framework 3.5 SP1
To install .NET Framework 3.5 on supported Windows and Windows Server
operating systems, either automatically or manually, ensure that the computer
is connected to the Internet and that the Windows Update service is enabled.

• .NET Framework 4.8
NOTE: .NET 4.8 Framework is already installed on Windows 10 version
1903 and subsequent supporting versions.

Depending on the Windows version and/or the computer configuration, .NET 3.5
SP1 can be:

• Not installed
• Installed but not enabled (The corresponding Windows feature is not set to

ON)
• Installed and enabled (Only this configuration is compatible with the

installation of EcoStruxure Control Expert)
NOTE: If either .NET Framework is not installed or incorrectly configured,
Setup displays a message.

Using a Virtual Machine
EcoStruxure Control Expert runs on the following virtual machines:

• VMware Workstation Pro 16 and 17
• Oracle VirtualBox 6.1.0 and 7.0.22
• Microsoft Hyper-V

Before starting EcoStruxure Control Expert, ensure that the 3D graphics
acceleration of the virtual machine is disabled. Otherwise, you may experience
incorrect graphic display.

Ensure that out of the total amount of installed RAM, at least 8 GB remain
available to the host computer.

Firewall
After EcoStruxure Control Expert is installed and the computer is restarted, the
SE.Automation.SystemManager.Service.exe service is executed.

If a firewall is active on the computer, ensure that the execution of this service is
authorized on the computer acting as Control Expert server. Otherwise,
EcoStruxure Control Expert instances cannot connect to the server.
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Access Rights

User Access Rights
EcoStruxure Control Expert is installed so that it is available to all the users of the
computer.

Administrator rights are not required to start EcoStruxure Control Expert.

However, you must have Administrator rights to perform the following actions:
• Installing, repairing, modifying, and removing EcoStruxure Control Expert.
• Changing the display language.
• Updating the Hardware Catalog (CANopen, DTM) and the Types Library.
• Managing Custom Libraries and Families in the Types Library Manager.
• Using the PROFIBUS Remote Master (PRM) DTM.

User access rights are managed by Security Editor. For more information, refer to
the Prerequisites in the topic Starting EcoStruxure Control Expert Classic, page
46.

Folder Access Rights
Ensure that all the folders used by EcoStruxure Control Expert are accessible in
Read/Write mode, and that the folder at the path C:\UnityProTemp (hidden) has
the following rights: Read, Execute, Write.

To view the folder paths, in the EcoStruxure Control Expert menu bar, click Tools
> Options > General > Paths. The following locations are available:

• Project path
• Import/export file path
• XVM path
• Project settings templates path
• Project settings template file
• Custom Library path
• Working drive
• Log file path

If a path is not accessible, a message is displayed and the operation needing
access is not executed.

NOTE: Because some components accessed by EcoStruxure Control Expert
are shared, ensure that the access rights are the same for all users logging
into the computer.
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Client/Server Communication Ports
The following table describes the ports that are used by EcoStruxure Control
Expert.

Port Description Value

Base port Port (UDP and TCP) that is used for client/server
communication.

20160

File transfer
port

Port (TCP) that is used for client/server file transfers.

The port is automatically transferred to EcoStruxure Control
Expert (client) instances.

20161

Critical
messaging port

Port (TCP) that is used to maintain a continuous client/
server communication link. It is used by the SE.Automation.
SystemManager.exe and SE.Automation.ToolAgent.exe
processes.

20162
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Communication Drivers

Overview
Installing EcoStruxure Control Expert installs the following communication drivers:

• Modbus serial
• USB
• XIP

The drivers create the connection between the computer and the controller. You
can select the driver that you want to use in EcoStruxure Control Expert.

Driver Configuration and Installation
Generally, it is not necessary to change the configuration of installed drivers.
However, you can use the Driver Manager tool to reconfigure a driver or install
additional drivers.

For information about driver configuration and installation, refer to Communication
Drivers, Installation Manual.

NOTE: The necessary information to manually install the Uni-Telway driver is
displayed in the Installation Wizard at the end of the EcoStruxure Control
Expert installation process.

Communication Driver Ports
Each connection requires one driver instance, which uses one port, except for
drivers communicating with the XWAY protocol (for example, XIP), which use two
ports.

The ports used by a driver instance are open while the driver instance is running.
Driver instances can be started and stopped with the Driver Manager tool.

NOTE: It is a good practice to uninstall a driver if it is not used.
These ports can be used by a driver instance:

Port range Driver Protocol family

27700–27709 Modbus serial Modbus

27710–27719 Modbus Plus (MB+) Modbus Plus

27730–27739 FIP XWAY

27780–27789 XIP

NOTE: You can change the base port number (27700) by editing the FirstPort
value of the Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Schneider
Electric\NetAccess Windows registry key.

Examples:

The first and second instances of the Modbus serial driver use ports 27700 and
27701 respectively.

The first instance of the XIP driver uses ports 27780 and 27781.

Opening the Driver Manager Tool
To open the Driver Manager tool, enter Driver Manager in the Windows search
bar.
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Demonstration Projects and Additional Resources

Demonstration Projects
There is an EcoStruxure Control Expert Classic demonstration project for each
controller platform.

Demonstration project files (.stu) are copied to the computer during the installation
at the path C:\Users\Public\Public Documents\Schneider Electric\Control Expert
X, where X is the installed version.

The projects are read-only but you can change this attribute from the project
properties or by saving the project with a new name.

Additional Resources
The following additional resources are available in the Extras folder. The folder is
copied to the computer during the installation of EcoStruxure Control Expert at the
path C:\Users\Public\Public Documents\Schneider Electric\Control Expert X,
where X is the installed version.

Subfolder Content description

Config DRS Contains configuration files for Dual Ring Switches (DRSs).

For more information on DRS configuration files, refer to the topic describing
DRS predefined configuration files (see Modicon M580, Complex Topologies,
System Guide).

Converter
Quantum M580

Contains the PLCSTAT DFB for Modicon M580 controllers. Use this DFB after
migration from the Quantum to the M580 platform if the application contains a
PLCSTAT DFB.

Excel Import
Export Tool

Contains a tool that facilitates the export and import of variables to Microsoft
Excel.

Operator
Screens

Contains operator screen templates for M580 redundant controllers.

UDE Contains documentation for EcoStruxure Control Expert Application
Programming Interfaces (APIs) that help automate project engineering tasks,
such as creating applications, adding modules, importing a section, building the
project, or downloading the project to the controller.
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First-Time Installation

Overview
This chapter describes a first-time installation of EcoStruxure Control Expert on a
computer.

NOTE: If Unity Pro is installed on the computer, refer to Upgrading From
EcoStruxure Control Expert or Unity Pro, page 26 for information on
operations to perform before and after installing EcoStruxure Control Expert.

Installing EcoStruxure Control Expert

Installation Types
You can choose between these installation types during the installation procedure.

Installation type Description

Typical Installs the following software components and functionalities, page
13:

• EcoStruxure™ Control Expert
• EcoStruxure™ Control Expert Classic
• Security Editor
• PLC Simulator

Optionally, you can install the following software components:
• Schneider Electric Software Update (SESU): This application

allows you to receive notifications about new firmware and
software updates, and install them. An internet connection is
required.

• Floating License Manager: This application allows you to share
seats of floating Schneider Electric software licenses within your
organization.

Custom You can choose which of the following functionalities or software
components to install:

• EcoStruxure™ Control Expert (requires EcoStruxure™ Control
Expert Classic)

• EcoStruxure™ Control Expert Classic
• Security Editor
• PLC Simulator
• Schneider Electric Software Update (SESU)
• Floating License Manager
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Additional Components Installed
The following software components are installed regardless of the installation
type:

• communication drivers, page 19
• PL7 convertor utility
• Concept convertor utility
• OS Loader
• Libset Installer: You can use this tool to install a set of library (Libset) versions

that are not available on your computer, if required.
NOTE: Only Libset 12.0 and subsequent supporting versions are
automatically installed. For more information, refer to Libset (Set of
Libraries) (see EcoStruxure™ Control Expert, Operating Modes).

• Device Type Managers (DTMs) associated to controllers and modules
available in the EcoStruxure Control Expert Hardware Catalog

• License Manager
NOTE: Some equipment supported by EcoStruxure Control Expert or
EcoStruxure Control Expert Classic may require the installation of additional
software to use and configure the equipment, such as Altivar Process Variable
Speed Drives or Advantys islands DTMs.

Optional Applications and Libraries
Before closing the Installation Wizard, you can download the following
applications and libraries:

• EcoStruxure Automation Device Maintenance (replaces OS Loader)
• EcoStruxure Control Expert Dif
• EcoStruxure Control Expert Dif
• Modicon General Purpose Library V1 for EcoStruxure Control Expert
• Modicon General Purpose Library V2 for EcoStruxure Control Expert

An Internet connection is required.

To install the application or library, use its installer after the download completes.

Certificates
For information on certificates, refer to Certificates for EcoStruxure Control Expert,
page 42.

Installation Folders
The default EcoStruxure Control Expert installation folder path is C:\Program Files
(x86)\Schneider Electric\EcoStruxure Control Expert X. You can change the path
during the installation.

NOTE: Do not exceed 110 characters if specifying a different installation folder
path.

The Custom Libraries installation folder is: C:\ProgramData\Schneider Electric
\EcoStruxure Control Expert X\CustomLibset\vX.

Where X is the EcoStruxure Control Expert version you are installing.
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Installation Procedure
Ensure that your computer meets the system and installation requirements to
install and run EcoStruxure Control Expert, page 15. Then perform the installation:

Step Action

1 Double-click the installation package image file (.iso) that you downloaded, page
13.

Result: The content of the file is displayed in the Windows File Explorer.

2 Double-click setup.exe to open the Installation Wizard.

3 Select the language and click OK.

4 Click Install to install the prerequisites and communication drivers, page 19.

5 Read, and if you agree, accept the End User License Agreement (EULA).

6 Choose the installation type, page 21.

7 Choose the software components to install.

8 To begin the installation, click Install.

9 When the installation is complete, choose the optional applications and libraries
to download, page 22.

Click Finish to close the Installation Wizard.

Result: The Release Notes open in the default browser and a dialog box opens
prompting you to restart the computer.

10 Click Yes to restart the computer.
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Silent Installation

Overview
The silent installation of EcoStruxure Control Expert does not require user
intervention during the installation after you choose which software components
and functionalities to install, page 13.

The silent installation requires manually editing the CE_SilentConfig.ini file located
in the root of the installation package (.iso) using a text editor and executing the
file. The installation requirements, page 16 and additional installed components,
page 22 are the same as for a manual installation.

You can use the silent installation to upgrade an earlier supported version of
EcoStruxure Control Expert.

To use the silent installation, you must have Administrator rights on the computer.

Migration of System Projects of an Earlier Version
If system projects that were automatically exported from an earlier version of
EcoStruxure Control Expert are present on the computer, they are imported when
you install the new version if they fulfill the following requirements:

• They support upward compatibility.
• They are not password-protected.

If other system projects that do not fulfill these requirements are present, you can
view and manage them in the Earlier Projects section of the Topology Manager
Start Page after upgrading.

For more information on the export, refer to Silent Installation, page 24.

For more information on the import, refer to the topic describing the Start Page
(see EcoStruxure™ Control Expert, Topology Manager, User Manual).

NOTE: If system projects are available for import but the Control Expert server
is not available, the silent installation is canceled and an event is logged in the
Windows Event Viewer. For more information, refer to connections to the
EcoStruxure Control Expert Server, page 44.
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Editing the Silent Installation Configuration File
To configure which EcoStruxure Control Expert components are installed, proceed
as follows.

Step Action

1 Copy the CE_SilentConfig.ini file from the extracted EcoStruxure Control Expert
installation package (.iso) and paste it to your local hard drive.

2 Double-click the CE_SilentConfig.ini file.

Result: The file opens in the default text editor.

3 Edit the parameters:
• InstallDir: Defines the installation path. If you enter a path, it must contain, at least,

one folder. Leaving the parameter blank installs EcoStruxure Control Expert at the
default path, page 22.

• DesktopShortcut: 1 adds the icons to the desktop. Blank does not add icons.
• QuickLaunch: 1 adds the icons to the Quick Launch bar. Blank does not add icons.
• Other parameters:
◦ Blank: Does not install the component.
◦ 1: Installs the component.

NOTE: The Installation Wizard automatically manages the installation of required
components. For example, it installs Control Expert Classic, Security Editor, and
PLC Simulator if you choose to install Control Expert (Topology_Manager=1).

4 Save changes and close the file.

Starting the Silent Installation
To install EcoStruxure Control Expert in silent mode, proceed as follows.

Step Action

1 Open a command prompt as Administrator.

2 Type X:\setup.exe /s /v”/qn INIFILEPATH=fullpath” where:
• X is the drive where the installation files (.iso) are mounted.
• fullpath is the full path of the CE_SilentConfig.ini file that you have edited (for

example, C:\MyFolder\CE_SilentConfig

3 Press Enter.

Result: The installation starts in the background.

4 Close the command prompt.
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Upgrading From EcoStruxure Control Expert or
Unity Pro

Overview
This chapter describes how to upgrade from an earlier version of EcoStruxure
Control Expert, EcoStruxure Control Expert Classic, or Unity Pro. The process
includes the management of the applications and settings.

If you upgrade from Unity Pro 5.0 or earlier, also refer to Preparing for the
Upgrade From Unity Pro 5.0 or Earlier, page 30 for additional information.
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Database and Library Management
The following tables describe the actions you can perform with the EcoStruxure
Control Expert Installation Wizard based on the version that is installed and the
impact of each action on databases and libraries.

From
ver-
sion/To
version

15.2 15.3 16.0 16.1 16.2

15.2 Repair Upgrade Upgrade Upgrade Upgrade

15.3 Remove Repair Upgrade Upgrade Upgrade

16.0 Remove Remove Repair, Modify Upgrade Upgrade

16.1 Remove Remove Remove Repair, Modify Upgrade

16.2 Remove Remove Remove Remove Repair, Modify

Action in
Installation
Wizard

Impact on databases and libraries

Repair,
page 50

Installed databases and libraries(1) are not repaired.

Modify,
page 49

It installs the databases and/or libraries that are required by the components you
install.

Remove,
page 51

The databases and libraries(1) are removed.
NOTE: Before installing the earlier version, DTM Libraries and other
components must be manually removed, page 52.
NOTE: If you install EcoStruxure Control Expert after removing an existing
installation, the Installation Wizard proceeds as it would for a first-time
installation.

Upgrade,
page 26

The following databases and libraries of the EcoStruxure Control Expert installation
are backed up and restored during the upgrade:

• The Security Editor database
• The system project database
• The Custom, EDS, and GSD Libraries
• The CANopen Library

The Libset of the EcoStruxure Control Expert installation is replaced by the Libset
12.0 and subsequent supporting Libset versions included with the EcoStruxure
Control Expert upgrade. To install earlier Libset versions, from the Windows Start
menu, click EcoStruxure Control Expert > Install libset tool.

NOTE: After you upgrade to EcoStruxure Control Expert 16.0 or any
subsequent supported version, the Security Editor database is restored the first
time you start Security Editor. You are prompted for the SecurityAdmin user
password of the earlier version and you must set a new password.

(1) Databases and libraries consist of:
• The Security Editor database
• The system project database
• The Libset (Set of Libraries) (see EcoStruxure™ Control Expert, Operating Modes)
• The Custom, Electronic Data Sheet (EDS), and General Station Description (GSD) Libraries
• The CANopen Library
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Preparing for the Upgrade

Overview
Before upgrading from an earlier version of EcoStruxure Control Expert or Unity
Pro, save or export your existing project files to reuse them.

This topic describes the steps for EcoStruxure Control Expert and EcoStruxure
Control Expert Classic/Unity Pro project files.

Exporting EcoStruxure Control Expert System Projects
If you created system projects (Topology Manager), upgrading EcoStruxure
Control Expert on the computer acting as Control Expert server, automatically
exports the system projects to the Migration folder at the path %ProgramData%
\Schneider Electric\ControlExpert.Topology.X where X is the version of
EcoStruxure Control Expert that they were created with.

Before proceeding with the upgrade, ensure that your system projects are upward
compatible (see EcoStruxure™ Control Expert, Topology Manager, User Manual);
otherwise, they cannot be used with the subsequent supporting version.

EcoStruxure Control Expert Classic and Unity Pro File Formats
Project files in the .STU format from your installed version are not compatible with
subsequent versions of EcoStruxure Control Expert Classic.

You can use the following version-independent file formats to restore your projects
in subsequent supporting versions of EcoStruxure Control Expert Classic, page
34.

File format Description

.STA archived
application file
format

These files are not version dependent. However, they can only be created
with projects that can be successfully built.

This file format allows you to connect to the controller in Equal mode after
opening the project with a subsequent supporting version of EcoStruxure
Control Expert.

NOTE: Each time a built project is saved in .STU format with Unity Pro
4.1 or later, an archived application file is automatically created with the .
auto.sta file name extension and saved at the same location as the .STU
file.
NOTE: Archived application files created as of EcoStruxure Control
Expert Classic 15.3 can also be imported in EcoStruxure Control Expert.
For more information, refer to the topic describing the import of control
projects (see EcoStruxure™ Control Expert, Topology Manager, User
Manual).

.XEF application
exchange file
format

These files are used to export a global project without the global DTM
configuration and are not version dependent. Use this file format if the project
cannot be built.

Importing an .XEF file requires a Rebuild All of the project.

.ZEF full
application
exchange file
format

These files are used to export projects with the configurations created using
DTMs and are not version dependent. Use this file format if the project
cannot be built. It is a good practice to export your projects to this file format
in addition to other formats.

Importing a .ZEF file requires a Rebuild All of the project.
NOTE: Full application exchange files (.ZEF) can also be imported in
EcoStruxure Control Expert. For M580 controller projects, the file must
be created with EcoStruxure Control Expert Classic as of version 15.0.
For more information, refer to the topic describing the import of control
projects (see EcoStruxure™ Control Expert, Topology Manager, User
Manual).
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For additional information about file formats, refer to:
• Services in Offline Mode (see EcoStruxure™ Control Expert, Operating

Modes)
• User Applications and Projects File Formats (see EcoStruxure™ Control

Expert, Program Languages and Structure, Reference Manual)
For information about project compatibility between EcoStruxure Control Expert
Classic/Unity Pro versions and controller firmware versions, refer to EcoStruxure
Control Expert, Application Versions and Controller Firmware, Compatibility
Rules, User Manual.

Saving EcoStruxure Control Expert Classic or Unity Pro Files to .
STA Format

Step Action

1 Start the installed version of EcoStruxure Control Expert Classic or Unity Pro.

2 Open the project file (.STU) by clicking File > Open, selecting a file, and clicking Open.

3 Click File > Save Archive.
NOTE: The command is only available if the following conditions apply:

• The project was generated.
• The Tools > Project Settings > General > PLC embedded data > Upload

information property is selected and at least Comments or Animation
tables is selected.

4 Choose a location to save the file and click Save.
NOTE: Do not save files in the default Schneider Electric folders C:\Program Files
\Schneider Electric or C:\Program Files (x86)\Schneider Electric. Files saved in
these folders are deleted during an upgrade.

Exporting EcoStruxure Control Expert Classic or Unity Pro Files
to .XEF or .ZEF Format

Step Action

1 Start the installed version of EcoStruxure Control Expert Classic or Unity Pro.

2 Open the project file (.STU) by clicking File > Open, selecting a file, and clicking Open.

3 Click File > Export Project.

4 Choose a location to save the file.
NOTE: Do not save files in the default Schneider Electric folders C:\Program Files
\Schneider Electric or C:\Program Files (x86)\Schneider Electric. Files saved in
these folders are deleted during an upgrade.

5 Click Export and select the .ZEF or .XEF export file format.
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Preparing for the Upgrade From Unity Pro 5.0 or Earlier

Overview
This topic contains information about the upgrade from Unity Pro 5.0 or earlier.

If you are upgrading from Unity Pro 3.1 or earlier and have used Custom Libraries
(user-created libraries with Families containing objects such as EFs, EFBs, DFBs,
and DDTs) and/or a Private ASI catalog, refer to the sections describing how to
save them.

Considerations when Upgrading from Unity Pro 5.0 or Earlier
The following table describes specific use cases when upgrading from Unity Pro
5.0 or earlier and the actions to perform.

Unity Pro
version

Description Actions

5.0 The Installer of the DTM
Library does not fully
manage the removal of the
previous DTM versions
installed with Unity Pro 5.0.
This may lead to an incorrect
installation of the DTMs (for
example, Generic DTMs).

Before upgrading, uninstall previous versions of the
LOKI and Generic DTMs with the Windows Add or
remove programs functionality.

Earlier
than 3.0

For built projects, packing
the memory of a Premium
controller in RUN mode may
lead to an unintended
controller stop.

Open the .STA archive file of the project with Unity Pro
3.0 or later and select the Rebuild All of the project.
Then, download the rebuilt project to the controller.
This requires stopping the controller but helps avoid
future unintended controller stops when packing the
memory in RUN mode.

For more information, refer to Service in Offline Mode
(see EcoStruxure™ Control Expert, Operating Modes).

Earlier
than 2.0

The pin layout of the
Elementary Function Block
(EFB) COM_DB was
changed with Unity Pro 2.0.

Applications containing this EFB and designed with a
version earlier than 2.0 must be exported and
imported. In addition, new variables must be assigned
to the inputs and outputs of the EFB.

For more information, refer to COMP_DB: Comparison
(see EcoStruxure™ Control Expert, Control, Block
Library).
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Saving Custom Libraries and Families of Unity Pro 3.1 and Earlier
To save a Custom Library Family and the objects it contains, proceed as follows.

NOTE: For Unity Pro 4.0 and subsequent Unity Pro versions, the Custom
Libraries and Families of the installed version are kept at their original location
after you upgrade. Refer to Restoring Manually DFBs, DDTs, and FFBs in the
Types Library Manager, page 35.

Step Action

1 Start the installed Unity Pro by clicking Start > Programs > Schneider Electric >
SoCollaborative > Unity Pro > Unity Pro xx where xx refers to the Unity Pro package.

2 In the menu bar, click Tools > Types Library Manager.

3 Select a Family and right-click it.

4 Click Create an installable family.

5 Choose a location to save the Family.
NOTE: Do not save files in the default folders C:\Program Files\Schneider Electric
\Unity Pro or C:\Program Files (x86)\Schneider Electric\Unity Pro. Files saved in
these folders are deleted during an upgrade.

6 If sub-types need to be included, select the Include sub-types check box.

7 Click OK.

Result: Several DSC files and folders containing the Custom Library, the Family, and its
content are created.

8 Save your other Families by repeating steps 3 to 7.

9 Close the Types Library Manager.

For more information, refer to Types Library Manager, Creating an Installable
Family (see EcoStruxure™ Control Expert, Operating Modes).

Saving the Private ASI Catalog
If a Private ASI catalog is used, copy the following files to another folder to reuse
them after you upgrade:

• ...\Schneider Electric\ConfCatalog\Database\Asi \1031\private.ctg, private2.
ctg

• ...\Schneider Electric\ConfCatalog\Database\Asi \1033\private.ctg, private2.
ctg

• ...\Schneider Electric\ConfCatalog\Database\Asi \1034\private.ctg, private2.
ctg

• ...\Schneider Electric\ConfCatalog\Database\Asi \1036\private.ctg, private2.
ctg

• ...\Schneider Electric\ConfCatalog\Database\Asi \1040\private.ctg, private2.
ctg

• ...\Schneider Electric\ConfCatalog\Database\Asi \2052\private.ctg, private2.
ctg
NOTE: Do not save files in the default folders C:\Program Files\Schneider
Electric\Unity Pro or C:\Program Files (x86)\Schneider Electric\Unity Pro. Files
saved in these folders are deleted during an upgrade.
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Installing the EcoStruxure Control Expert Upgrade

Overview
When you upgrade EcoStruxure Control Expert, the Installation Wizard searches
for installed components, removes them, and installs the new version based on
the selected installation type, page 21.

On a computer acting as Control Expert server, after the upgrade is complete, you
are prompted to migrate the system projects of the earlier version, page 33.

Administrator Rights
To upgrade EcoStruxure Control Expert, you must have Administrator rights on
the computer.

Installation Procedure
• Ensure that your existing application data is saved and the preparation work

is completed. If you upgrade from Unity Pro, ensure that it is uninstalled.
• Ensure that your computer meets the system and installation requirements to

install and run EcoStruxure Control Expert, page 15.
Then, you can upgrade your EcoStruxure Control Expert installation:

Step Action

1 Double-click the installation package image file (.iso) that you downloaded, page
13.

Result: The content of the file is displayed in the Windows File Explorer.

2 Double-click setup.exe to open the Installation Wizard.

3 Select the language and click OK.

4 Click Install to install the prerequisites and communication drivers, page 19.

5 Read, and if you agree, accept the End User License Agreement (EULA).

6 Choose the installation type from the Installation Types table in the topic Installing
EcoStruxure Control Expert, page 21.

7 Choose the software components to install.

8 To begin the installation, click Install.

9 When the installation is complete, choose the optional applications and libraries to
download.

Click Finish to close the Installation Wizard.

Result: The Release Notes open in the default browser and a dialog box opens
prompting you to restart the computer.

10 Click Yes to restart the computer.
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Importing EcoStruxure Control Expert System Projects
and Topology Export Files

Importing System Projects
On a computer acting as Control Expert server, after the upgrade of EcoStruxure
Control Expert is complete, you are prompted to migrate (import) the system
projects of the earlier version that are located in the Migration folder and that are
upward compatible, page 28.

If a system project is password-protected, you must enter the password to migrate
it. You can choose to migrate only the system projects that are not password-
protected.

You can also manually import upward-compatible system projects from the Earlier
Projects section of the Topology Manager Start Page (see EcoStruxure™ Control
Expert, Topology Manager, User Manual).

NOTE: After you import a system project created with EcoStruxure Control
Expert 16.0 or earlier and containing an M580 controller with firmware version
4.0 or greater, you must change the default firmware password from the
System Project section of the User Preferences window. This requires that
you edit or build the control project of the M580 controller. As a result, if you
deployed the control project before importing it, you cannot connect to the
controller in equal state from the EcoStruxure Control Expert instance where
you imported it. To make online changes, you must deploy the control project
again, which requires stopping the controller.

Importing Topology Export Files
After you import a topology export file (.xpt) created with EcoStruxure Control
Expert 16.0 or earlier and containing an M580 controller with firmware version 4.0
or greater, you must change the default firmware password from the System
Project section of the User Preferences window or apply the firmware password
that is set. This requires that you edit or build the control project of the M580
controller. As a result, if you deployed the control project before importing it, you
cannot connect to the controller in equal state from the EcoStruxure Control
Expert instance where you imported it. To make online changes, you must deploy
the control project again, which requires stopping the controller.

For more information on the build state, refer to the topic describing the import of
objects in the topology (see EcoStruxure™ Control Expert, Topology Manager,
User Manual).
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Restoring Project Files and Settings After Upgrading

Overview
After the installation of the EcoStruxure Control Expert upgrade is complete,
project files and settings can be recovered by restoring them in the following
order:

1. Only if you upgraded from Unity Pro 3.1 or earlier:
• Custom Libraries and Families, page 34
• The Private ASI Catalog, page 35

2. For all versions: DFBs, Derived Data Types (DDTs), and FFBs. Refer to the
table of EcoStruxure Control Expert Classic and Unity Pro File Formats, page
28.

3. For EcoStruxure Control Expert Classic only:
• Archived application files (.STA), page 36
• Application exchange files (.XEF, .ZEF), page 36

NOTE: .STA and .ZEF can also be imported in EcoStruxure Control
Expert. Refer to the Unity Pro File Formats table in the topic
Preparing for the Upgrade, page 28.

Restoring Custom Libraries and Families
To restore a Unity Pro Custom Library Family that you saved, page 31, proceed as
follows.

Step Action

1 Close EcoStruxure Control Expert and EcoStruxure Control Expert Classic.

2 From the Windows Start menu, click EcoStruxure Control Expert > Types Library
Update.

3 Navigate to the folder where the Custom Library Family is stored, page 31, select the
FAMILY.DSC file, and click Open.

4 Select the Libset version where you want to install the Family.

5 Click Install family.

Result: The Custom Library Family is restored and a message box is displayed.
NOTE: If you receive the message The installation has succeeded but
there are warnings. Details are in file: <C:\WINNT\logunit
\install.log>, you can disregard it and click OK.

6 Repeat steps 3 to 5 for each Family that you want to restore.

7 Start EcoStruxure Control Expert Classic by clicking, from the Windows Start menu,
EcoStruxure Control Expert > Control Expert Classic.

8 To view the Custom Library, its Families, and their content, click Tools > Types Library
Manager and select the Libset version where you restored the Families.

For more information, refer to Types Library Manager (see EcoStruxure™ Control
Expert, Operating Modes).
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Manually Restoring DFBs, DDTs, and FFBs in the Types Library
Manager

You can manually restore Custom Libraries, their Families, and the objects they
contain, even if they were not saved.

This operation is useful in the following situations:
• You did not save Custom Libraries and Families, page 31 before upgrading.
• You have used custom FFBs defined with the EFB Toolkit. Refer to Types
Library Manager, Updating a Family of a Library (see EcoStruxure™ Control
Expert, Operating Modes)

The Custom Libraries folders are determined by the installed Unity Pro version
and the operating system. They are saved automatically during the installation
process at the following paths, where x.y or xx.yy is the version of the earlier Unity
Pro installation.

Version Operating
system

Path

Unity Pro 3.1 or
earlier

– C:\Program Files\Schneider Electric\Application Data
\Schneider Electric\Unity Pro\CustomLibset
\OldCustomdbxx.yy

Unity Pro 4.0 or
later

Windows 7, 10,
or 11

C:\ProgramData\Schneider Electric\Unity Pro
\CustomLibset\Vx.y

Windows XP C:\Program Files\Schneider Electric\Application Data
\Schneider Electric\Unity Pro\CustomLibset\Vx.y

To manually restore the Custom Libraries and Families, proceed as follows.

Step Action

1 Copy the content of the Custom Library from the corresponding folder.

2 Paste the content of the Custom Library folder into the new EcoStruxure Control Expert
Custom Library folder at the path C:\ProgramData\Schneider Electric\Control Expert ••.•
\CustomLibset\Vx.y, where ••.• is the installed version and x.y the earlier Unity Pro
version.

3 Repeat steps 1 and 2 for the Vx.y versions where the Custom Library is required.

Restoring the Private ASI Catalog
If you saved the private ASI catalog files, they must be restored to their original
location, page 31.
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Restoring Archived Application Files (.STA)
Use the .STA archived application file format if the controller cannot be stopped.

Follow these steps to restore the saved archived application files for each project:

Step Action

1 Start EcoStruxure Control Expert Classic by clicking, from the Windows Start menu,
EcoStruxure Control Expert > Control Expert Classic.

2 Click File > Open and select the .STA file.

3 Click Open.

4 Save the project as project file (.STU).

For more information about restoring saved or exported projects, refer to the table
of EcoStruxure Control Expert Classic and Unity Pro File Formats, page 28.

Restoring Application Exchange Files (.XEF and .ZEF)
Restoring an .XEF application exchange file or a .ZEF full application exchange
file requires a Rebuild All of the project.

Follow these steps to restore the exported application exchange files for each
project:

Step Action

1 Start EcoStruxure Control Expert Classic by clicking, from the Windows Start menu,
EcoStruxure Control Expert > Control Expert Classic.

2 Click File > Open and select the .XEF or .ZEF file.

3 Click Open.

4 Save the project as project file (.STU).

For more information about restoring saved or exported projects, refer to the table
of EcoStruxure Control Expert Classic and Unity Pro File Formats, page 28.
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Using Software Licenses
This chapter describes the types of licenses that are available for EcoStruxure
Control Expert and how to register your licenses.

Refer to these documents for more information on the use of licenses:
• For node-locked licenses, refer to Schneider Electric License Manager, User

Manual.
• For floating licenses, refer to Schneider Electric Floating License Manager,

User Manual.
Also refer to the videos explaining how to activate a node-locked license or a
floating license.

Software Licenses

Description
The software license determines the EcoStruxure Control Expert functionality and
version that you can use as described in the following table.

Software license EcoStruxure Control
Expert

EcoStruxure Control
Expert Classic

EcoStruxure Control Expert S No Yes

EcoStruxure Control Expert L No Yes(1)

EcoStruxure Control Expert XL No(2) Yes(1)

EcoStruxure Control Expert XL with
M580 Safety

No(2) Yes

EcoStruxure Control Expert XL with
Topology Manager and M580 Safety

Yes Yes

(1) You can use M580 safety-related controllers with the M580 Safety Add-On license.

(2) Control Expert is available with the Topology Manager Add-On license.

For information on the controller platforms supported by the different license
types, refer to the describing the capabilities of EcoStruxure Control Expert (see
EcoStruxure™ Control Expert, Operating Modes).

Two types of licenses are available for EcoStruxure Control Expert:
• A node-locked license for use on the local computer where EcoStruxure

Control Expert is installed. The license is activated using the License
Manager.

• A floating license for use with an authorized number of computers that are
connected to the Enterprise License Server. The license is activated using
the Floating License Manager.
NOTE: Use floating licenses to use remote desktop connections a with
Windows Server. Several remote desktop connections are supported but
limited by the available license-usage rights. With a node-locked license, only
one remote desktop connection is allowed, regardless of the number of seats
that are activated for the license.
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License Requirements When Upgrading
Generally, when you upgrade EcoStruxure Control Expert, the following applies:

• For a major release upgrade (for example, upgrading from version 14.1 to
15.0) or if you upgrade from Unity Pro, a new license activation is required.

• For a minor release upgrade (for example, upgrading from version 15.0 to
15.3), a license activation is not required. The license of the earlier version is
valid.

Trial License
EcoStruxure Control Expert installs with a 30-day trial license that is automatically
activated at the first start.

The trial license unlocks the product functionality that corresponds to the Control
Expert XL with Topology Manager and M580 Safety software license, page 37.

NOTE: When you activate a software license, the trial license is disabled.

License Backward Compatibility
A software license can be used with earlier supported EcoStruxure Control Expert
versions.
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Software License Registration

Overview
You can register your software license on the Schneider Electric Software
Licensing Web Portal (SLP).

The SLP is Schneider Electric Cloud service that lets you manage your Schneider
Electric software licenses on the Web. Registration is not mandatory and can be
done even if the license is not yet activated.

NOTE: Before registering a license, create your Schneider Electric Web User
Account.

When a licence is registered, the number of allowed returns, repairs, and reinstall
are increased as described in the following table.

Actions Single

(1 seat)

Group

(3 seats)

Team

(10 seats)

Entity

(100 seats)

Return 1 → 7 2 → 9 5 → 20 25 → 150

Repair 1 → 3 2 → 5 3 → 10 8 → 50

Reinstall 1 → 3 2 → 5 3 → 10 8 → 50

NOTE: A video is available explaining how to register your licenses.

Creating Your Schneider Electric Web User Account

Step Action

1
Go to www.se.com\licensing, or click on the globe icon on the License Manager /
Floating License Manager toolbar.

2 Select Login / Create my account.

3 Enter your email address that will be your user ID for your Schneider Electric Web User
Account.

Fill in the mandatory fields and validate.

Registering a License

Step Action

1 Log in to the Schneider Electric Software Licensing Web Portal (SLP).

2 Select Register license into my account.

3 Enter the license Activation ID and click Register.
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Enabling Client/Server Communication

Reinforcing Communication Security Between the Server
and Clients

Overview
This topic describes how to connect an EcoStruxure Control Expert instance to a
remote Control Expert server.

NOTE: Reinforcing client/server communication security helps reduce
vulnerability to cyberattacks.

Configuring the Control Expert server Server Listening IP
Address

To manage and restrict access from EcoStruxure Control Expert to the Control
Expert server, proceed as follows.

Step Action

1 On the computer acting as Control Expert server, from the Windows Start menu, expand
the EcoStruxure Control Expert folder, right-click Server Configuration, and click
Run as administrator.

Result: The Server Configuration tool opens.

2 In the Listening Connections section, select the Listening IP address value from the
list:

• 127.0.0.1 (Local connection): The server does not allow connections from remote
EcoStruxure Control Expert instances. (Default value.)

• 0.0.0.0 (All connections): The server allows connections from a local and remote
EcoStruxure Control Expert instances independently of the network they belong to.

• Network adapters of the server computer: The server only allows connections
from EcoStruxure Control Expert instances that are on the same network as the
adapter.

3 Click Apply, confirm the command, and close the Server Configuration tool.
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Reinforcing Communication Security
The following procedure that applies to Windows Defender is given as an example
only. Other antivirus applications may have different configuration steps.

Step Action

1 On the computer acting as Control Expert server, open Windows Defender Firewall
with Advanced Security (wf.msc) using the Microsoft Management Console (mmc.
exe).

2 Click Inbound Rules in the left pane. In the Action pane, click New rule… to proceed to
the New Inbound Rule Wizard.

3 In the Rule Type settings, select Custom and click Next to proceed to the Program
settings.

4 Select This program path:, set C:\Program Files (x86)\Schneider Electric
\Control Expert X\Server\SE.Automation.SystemManager.exe (where X is
the version that is installed), and click Next to proceed to the Protocols and Ports
settings.

5 Set the following values:
• Set Protocol Type to TCP.
• Set Local Port to Specific Ports and enter <base port>-<base port + 2> as

port range (for example, 20060–20062). For information on the base port number,
refer to Client/Server Communication Ports, page 18.

Click Next to proceed to the Scope settings.

6 Leave the settings as they are and click Next to proceed to the Action settings.

7 Select Allow the connection if it is secure and click Next to proceed to the Users
settings.

8 Leave the settings as they are and click Next to proceed to the Computers settings.

9 For Authorized computers, select Only allow connections from these computers, add
authorized computer names, and click Next to proceed to the Profile settings.

10 Select Domain, clear Private and Public, and click Next to proceed to the Name
settings.

11 In the Name box, enter SystemManager and in the Description box enter TCP rules.
Click Finish.

12 In the Inbound Rules pane, copy and paste the SystemManager rule.

13 Select the pasted SystemManager rule and click Properties.
• In the General tab, change the description from TCP rules to UDP rules.
• In the Protocols and Ports tab:
◦ Set Protocol Type to UDP,
◦ Set Local Port to Specific Ports and enter the base port number as port

range. For information on the base port number, refer to Client/Server
Communication Ports, page 18.

Click OK to close the Properties window.

14 Close the Microsoft Management Console.
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Certificates for EcoStruxure Control Expert

Certificate Installation
After you install EcoStruxure Control Expert, the first time you open Security
Editor, it automatically installs the ControlExpert and SecurityService
certificates that are required to use Control Expert with an all-in-one architecture,
page 14.

The certificates are added to the local Windows computer certificate store (certlm.
msc) under Personal\Certificates.

NOTE: To open Security Editor for the first time, you must set a password for
the SecurityAdmin user account.
NOTE: To connect EcoStruxure Control Expert instances to a remote Control
Expert server in a distributed architecture, ensure that the necessary
configurations are made and prerequisites are fulfilled, page 44.

Troubleshooting
If you are unable to connect to the Control Expert server and/or the server does
not start because a valid certificate was not found, the following information is
available for troubleshooting:

• On the computer acting as Control Expert server, an event of type Error is
recorded in the Windows Event Viewer (Windows Logs > Application,
Source = ControlExpert.Topology x, where x is the installed version).

• On remote computers from where the EcoStruxure Control Expert instance is
attempting to connect to the server, a message box opens.

For more information, refer to the topic describing certificate actions (see
EcoStruxure™ Control Expert, Security Editor, Operation Guide).
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Date and Time on Client/Server Computers
When you connect an EcoStruxure Control Expert instance to a remote Control
Expert server, ensure that the date and time on both computers is the same if you
use the following settings in the Login Policies tab of Security Editor:

• Authentication Mode: Centralized, Centralized,Local, or Local,Centralized
• Centralized Protocol: Network

Otherwise, you cannot use EcoStruxure Control Expert editor, import EcoStruxure
Control Expert Classic projects, and update the DTM catalog.
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Starting Control Expert and Control Expert Classic

Starting EcoStruxure Control Expert

Connection to the Control Expert Server
By default, EcoStruxure Control Expert instances are configured to connect to the
local Control Expert server at the address localhost:<base port> after you
log in. For information on the base port number, refer to Client/Server
Communication Ports, page 18.

To connect to a remote Control Expert server, page 14:
• On the server computer, configure the server listening address, page 40.
• On the local computer, the SecurityAdmin user must enter the Control Expert

server IP address and the SecurityService port number (indicated in the
Server section of Security Editor on the remote computer) in the Certificate
whitelist tab of Security Editor and trust the certificates.
For more information, see EcoStruxure™ Control Expert, Security Editor,
Operation Guide.

• In the EcoStruxure Control Expert instance, change the server IP address in
the Networks and Servers section of the User Preferences window (see
EcoStruxure™ Control Expert, Topology Manager, User Manual).
NOTE: Any computer on which EcoStruxure Control Expert is installed can act
as Control Expert server. The SE.Automation.System Manager.exe
server service is configured to start automatically with the computer.

Prerequisites
To start EcoStruxure Control Expert and log in, the following prerequisites must be
fulfilled:

• You have activated an EcoStruxure Control Expert license that includes rights
for the Topology Manager, page 37 (before the trial license expires).

• On the computer acting as Control Expert server, in Security Editor, Policies
tab, Login is set to either of these values:
◦ Security On, mandatory login
◦ Security off

• On the computer acting as Control Expert server, the SecurityAdmin user has
created or enabled user accounts as follows depending on the
Authentication Mode configured in the Login Policies tab of Security Editor
(see EcoStruxure™ Control Expert, Security Editor, Operation Guide):
◦ Local: User accounts are created or enabled in the local Security Editor

(Control Expert server computer) regardless of the selected local Login
(Policies tab).

◦ Centralized: User accounts are created or enabled in the remote Security
Editor or exist on the Lightweight Directory Access Protocol (LDAP)
server.

For more information on authentication methods, refer to Login Policies (see
EcoStruxure™ Control Expert, Security Editor, Operation Guide).
NOTE: To open Security Editor for the first time, set a password for the
SecurityAdmin user account.
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Starting an EcoStruxure Control Expert Instance

Step Action

1 From the Windows Start menu, click EcoStruxure Control Expert > Control Expert.

Result: The EcoStruxure Control Expert and the log-in windows open.

2 Enter a valid user name. If a password is set for this user account, enter it.

Result: The EcoStruxure Control Expert instance connects to the Control Expert server
and displays the system projects that exist in the server repository.

NOTE: After you log in, if the local Login policy (Security Editor, Policies tab)
is Security on, mandatory login or if you authenticate using a centralized
database (Login Policies tab), the EcoStruxure Control Expert functionality
that you can use is determined by the profile associated to the logged-in user
account. For more information, refer to the topic describing profiles (see
EcoStruxure™ Control Expert, Security Editor, Operation Guide).
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Starting EcoStruxure Control Expert Classic

Prerequisites
To start EcoStruxure Control Expert Classic, a software license, page 37 must be
activated (before the trial license expires).

NOTE: With the default Security Editor login policy, users can use
EcoStruxure Control Expert Classic without logging in. If the policy is changed,
requiring users to log in, the SecurityAdmin user must create and/or enable
user accounts as follows:

• For local authentication: In the local Security Editor.
• For centralized authentication: In the remote Security Editor or users must

exist on the Lightweight Directory Access Protocol (LDAP) server,
depending on the authentication.

For more information, refer to the topics describing user functions and login
policies (see EcoStruxure™ Control Expert, Security Editor, Operation Guide).
NOTE: To open Security Editor for the first time, you must set a password for
the SecurityAdmin user.

Starting an EcoStruxure Control Expert Classic Instance

Step Action

1 From the Windows Start menu, click EcoStruxure Control Expert > Control Expert
Classic.

Result: If you are starting EcoStruxure Control Expert Classic after activating a license,
the Package Selector dialog box opens, page 46. Otherwise, EcoStruxure Control
Expert Classic opens.

2 Select a license and click OK.

Result: EcoStruxure Control Expert Classic opens.

License Selection for EcoStruxure Control Expert Classic
The first time you start EcoStruxure Control Expert Classic after activating a
software license, you must select the package that corresponds to your software
license in the Package Selector dialog box.

NOTE: If you have several software licenses activated, the Package Selector
tool selects by default the highest package level (XL > L > S).
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The Package Selector tool differentiates the base packages (S, L or XL) but
additional functionality included with a license, such as M580 safety, is not
indicated. Therefore, select the base package that corresponds to your software
license, page 37.
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Changing the Display Language
To change the language of EcoStruxure Control Expert and EcoStruxure Control
Expert Classic, proceed as follows.

Step Action

1 From the Windows Start menu, click EcoStruxure Control Expert > Language
selection.

Result: The Control Expert Language Selection dialog box opens.

2 Select the language you want to use and click Apply.

Result: Your language selection takes effect the next time you start EcoStruxure Control
Expert or EcoStruxure Control Expert Classic.
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Modifying, Repairing, and Removing EcoStruxure
Control Expert

Using the Modify Functionality

Overview
The Modify functionality allows you to add software components to an existing
EcoStruxure Control Expert installation.

You cannot use the Modify functionality to remove installed components.

Modifying the EcoStruxure Control Expert Installation

Step Action

1 Ensure that the EcoStruxure Control Expert components installed on the computer are
closed.

2 Extract the files of the installation package (.iso) to disk or mount the image and double-
click setup.exe in the root of the installation package.

Result: The EcoStruxure Control Expert Installation Wizard starts.

3 In the Program Maintenance window, select Modify and click Next.

Result: The Custom Setup window opens.

4 Select the check box of the software components you want to add and click Next. For
more information, refer to Installing EcoStruxure Control Expert, page 21.

Result: The Ready to Install the Program window opens.

5 Click Install to install the components.

6 When the installation is completed, click Finish to close the Installation Wizard and
restart the computer when prompted.

NOTE: You can download additional applications and libraries before closing the
Installation Wizard.

35014793.19 49

Modifying, Repairing, and Removing EcoStruxure Control
Expert



Using the Repair Functionality

Overview
The Repair functionality attempts to repair missing or corrupted files in an existing
EcoStruxure Control Expert installation.

Also refer to Database and Library Management, page 27.
NOTE: A corrupted DTM installation cannot be repaired. In that case, remove
it with the Windows Add or remove programs functionality and then, reinstall
it.
NOTE: The Repair functionality does not install Libset files. To update Libset
files, use the Libset Installer tool.

Repairing the EcoStruxure Control Expert Installation

Step Action

1 Ensure that the EcoStruxure Control Expert components installed on the computer are
closed.

2 Extract the files of the installation package (.iso) to disk or mount the image and double-
click setup.exe in the root of the installation package.

Result: The EcoStruxure Control Expert Installation Wizard starts.

3 In the Program Maintenance window, select Repair and click Next.

4 Start the repair by clicking Install and follow the on-screen instructions.

Repairing the EcoStruxure Control Expert Installation in Silent
Mode

Step Action

1 Open the CE_Config.ini file located at the path C:\Program Files (x86)\Schneider
Electric\EcoStruxure Control Expert X where X is the installed EcoStruxure Control
Expert version.

2 In the file, on the line starting with Repair=msiexec.exe, copy the text from msiexec.exe
/foums to /qn.

For example, copy msiexec.exe /foums {a5eaa543-1010-45a1-892e-598f35a6f254} /qn.

3 Open a command prompt as Administrator.

4 In the command prompt, paste the text and press Enter to start the repair.
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Using the Remove Functionality

Overview
The Remove functionality removes EcoStruxure Control Expert from the
computer, except for the following:

• EcoStruxure Control Expert Classic user application files.
• EcoStruxure Control Expert database backup files.
• Components used by other installed Schneider Electric software (for

example, certain DTMs or the License Manager).
• Components that you manually installed for EcoStruxure Control Expert such

as drivers and DTMs.
Also refer to Database and Library Management, page 27.

When to Remove EcoStruxure Control Expert
Remove EcoStruxure Control Expert in the following cases:

• To install an earlier version than the one installed.
• To install Unity Pro.

Before installing Unity Pro or an earlier version of EcoStruxure Control Expert,
remove the following folders if they are not used by another Schneider Electric
software:

• C:\Program Files (x86)\Common Files\Schneider Electric
Shared\Tlb

• C:\Program Files (x86)\Common Files\Schneider Electric
Shared\Common

• C:\Program Files (x86)\Common Files\Schneider Electric
Shared\SRCSDK

• C:\Program Files (x86)\Common Files\Schneider Electric
Shared\SSTA

In addition, to install EcoStruxure Control Expert 16.0, remove the following, using
the Windows Control Panel:

• The License Manager
• The Floating License Manager
• The Schneider Electric Software Upgrade (SESU) tool

NOTE: Installing Unity Pro or an earlier version of EcoStruxure Control Expert
may lead to incompatibilities with other software, such as OPC Factory
Server, UDE and UAG.
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DTM Libraries
Removing EcoStruxure Control Expert also removes the following DTM Libraries
from the computer:

• EcoStruxure Control Expert PSx DTM Library
• Schneider Electric BME NOR DTM Library
• Schneider Electric Edge I/O DTM Library
• Schneider Electric Mx80 HART Gateway DTM Library
• Schneider Electric Placeholder DTM Library
• Schneider Electric PME DTM Library
• CXM DTM

NOTE: The installation packages of these DTM Libraries are provided in the
DTM_Installers folder of the EcoStruxure Control Expert installation
package (.iso). You can use them to individually remove or reinstall DTMs.

Node-Locked Licenses Returns
If you have activated a node-locked license, return the license, page 37 before
removing EcoStruxure Control Expert so that you can activate it on another
computer.

NOTE: The License Manager is removed if it is not required by another
program.

Removing EcoStruxure Control Expert with the Setup File

Step Action

1 Reboot the computer where EcoStruxure Control Expert is installed.

2 Extract the files of the installation package (.iso) to disk or mount the image and double-
click setup.exe in the root of the installation package.

Result: The EcoStruxure Control Expert Installation Wizard starts.

3 In the Program Maintenance window, select Remove and click Next.

4 Start the removal by clicking Remove and follow the on-screen instructions.

Removing EcoStruxure Control Expert with the Windows Control
Panel

Step Action

1 Reboot the computer where EcoStruxure Control Expert is installed.

2 From the Windows Control Panel, select Uninstall a program.

3 Right-click Control Expert, select Uninstall, and click Yes to confirm.

4 Follow the on-screen instructions.
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Removing EcoStruxure Control Expert in Silent Mode

Step Action

1 Reboot the computer where EcoStruxure Control Expert is installed.

2 Open the CE_Config.ini file located at the path
C:\Program Files (x86)\Schneider Electric\EcoStruxure Control Expert X where X is the
installed EcoStruxure Control Expert version.

3 In the file, on the line starting with Uninst=msiexec.exe, copy the text from
msiexec.exe /x to /qn.

For example, copy msiexec.exe /x {a5eaa543-1010-45a1-892e-598f35a6f254} /qn.

4 Open a command prompt as Administrator.

5 In the command prompt, paste the text and press Enter to start the removal of
EcoStruxure Control Expert.
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